
Easy HUD V3.0 
Quick Start Guide & Frequently Asked Questions  

 (Last updated: February 26, 2010, Easy Soft) 
 

DISCLAIMER 
The documents assembled here are provided to the user solely for informational and illustrative purposes 
and does not constitute a legal opinion, nor should they be relied upon as such. The information reflects a 
general understanding of the Rule promulgated by the Department of Housing and Urban Development 
(HUD) in November 2008 as of November 17, 2009. While every effort is made to provide the most recent 
information, the user is cautioned that there may be changes and that this may not be the final version of 
the Rule, its implementation issues or the Forms.  
 
In any event, the user is urged to frequently check the official documents posted at the Department of 
Housing and Urban Development website (www.hud.gov) and for specific issues, should consult the 
lender for whom any form is being prepared or seek independent counsel for final guidance.  This is an 
informal document which is a collection of notes from many different sources exclusively for the use of 
Easy HUD software users.   
 
New RESPA rules require preparation of a GFE-HUD compare sheet which lists charges in separate 
tolerance groups. We refer to these groups as Bucket 1 (0% tolerance, charges can not increase), Bucket 
2 (10% tolerance, Total of this group must not exceed by more than 10%) and Bucket 3 (no tolerance. 
Individual charges can increase). 
 

Quick Start Guide 
 
This section outlines steps required to be taken before you can start using the program for the first time. 
1. Install the software by downloading from website or from the installation CD. 
2. If you have purchased the program and received the 5-digit Product ID, activate the program (Click 

on “Help/Activate” and then select “Activate”). Otherwise the program will run in demo format. Demo 
format limits number of cases you can prepare and will print “DEMO” mark on all printouts. 

3. Complete Help PDF Manual is available under Help/Activate button. 
4. Set your preferences: Tools-> Default Settings. There are 3 Tabs: 

a. Settlement Agent: Fill-in settlement agent’s information. All new files will be pre-filled with this 
information in the appropriate sections. 

b. Configuration: You can choose different options. See help manual for more details.  
i. Default HUD Database & Default File Save locations are most important. For multi-

user environment, all users can point it to a shared network location and thus will be 
able to view/access entire group’s files. 

ii. Default Jurisdiction: to allow Easy HUD to compute transfer taxes (e.g. Realty 
Transfer Fee in NJ), set your default jurisdiction choice. From file to file, you will still 
be able to change it. 

iii. Default Application: Choose if you want purchase or refinance as default opening 
screen. 

c. Email Setup: If you would like to email prepared forms within the program, set your email 
settings and ensure to test it. 

 
Section 1: General 

 
1. How do I know my Easy HUD 3.0 is up to date? 
⇒ In the top row, last button, click on “Help/Activate” and select “About”. 
⇒ Current version of the HUD is 3.0.14. 
⇒ If this is not your version, we recommend you update your program. Please note, if you have multiple 

computer licenses, you will need to perform this update on all machines. 
⇒ To update, close your program and click on: http://www.easysoft-usa.com/EH300update 
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⇒ Click on “Run or Open” when prompted (Firefox users will need to save the file and double click on 
that). 

⇒ Follow the update instructions. Once complete, open the program and check your version number 
again. In some rare cases, this step might need to be performed twice.  

2. I see purchase screen only (HUD-1). I need to prepare a refinance (HUD-1A). How do I switch? 
⇒ Click in “File” menu. Under New or Open you have a choice of either a purchase or refinance file. 
3. Does program perform tax prorations? 
⇒ Click on “Tools” menu and select “Tax Proration”. You will find comprehensive choices and 

appropriate HUD-1 lines will be filled in on clicking Apply. 
4. How do set my printing preferences, so HUD always prints in “Legal” size? 
⇒ In the “File” menu, select “Print Setup”. You can specify default printer, tray and size to be used for 

HUD printing. 
5. My lender does not want signature lines on page2 of HUD-1 and page1 of HUD-1A. How do I move 

signature lines away? 
⇒ We are aware that some lenders are not accepting new RESPA forms with signature lines. While 

signature lines were never mandatory, it was customary all along and all lenders were requiring 
it/accepting it. Anyway, you can print HUD-1/HUD-1A with signature on a separate page. For this, 
uncheck the checkbox “Print the certification and signatures….” In the program screen at the bottom 
of page2 for HUD-1 and page1 for HUD-1A. Program will then print signature block separately for this 
particular file. 

6. I am viewing HUD in legal size and then printing. But it’s cutting off at the bottom? 
⇒ Most likely cause of this is you are viewing in Legal size format but while printing you are not 

selecting Legal size print option in the printer setting. You must set legal size page as well as 
appropriate tray. If you always print in Legal size, you may set your settings in File -> Print Setup. 

7. For a particular closing lender is asking additional annotation to be made or information entered. I do 
not see any place in Easy HUD for that? 

⇒ Easy HUD software and printouts are designed based on standard forms published by HUD. We 
understand that some lenders may still want extra information to be shown. If for any thing you do not 
find a place in the HUD software, the last and best option is to click on “Edit” while you are previewing 
the forms. Now you can type anything wherever you want. Please note that this change will need to 
be made every time as software is not saving your changes. You can save the form as Word and 
keep a copy for you.  

8. Can I print a mark on the HUD such as Draft or Preliminary or Amended etc? 
⇒ Yes. In the top section of the HUD screen, below the Loan Number box, look for Status column. Once 

you make a change here and print HUD, it will show a mark except when Status is “Final”. 
9. How can I compute transfer taxes (e.g. Realty Transfer Fee) in the HUD software? 
⇒ In the section 1200, ensure to select your Jurisdiction. 
⇒ If you click on “Tax Tables”, your transfer fee will be automatically computed and shown. If you press 

OK, computed values will be placed in appropriate lines. 
⇒ If you see your jurisdiction values being computed wrongly, please contact Easy Soft.  
⇒ You can also set your default jurisdiction under “Tools”->”Default Setting”->”Configuration”. 
10. My Jurisdiction is not shown in the available list for Transfer Taxes in section 1200. 
⇒ You can create your own list using templates feature. Create a blank HUD form. In “Jurisdiction”, 

select “None”. Enter appropriate transfer taxes rates as well as % share paid by buyer and seller. 
(Look at the Help button at the bottom to learn how calculations are made). Click on OK. 

⇒ Test your calculations. By changing purchase price and/or loan price, ensure to test your calculations 
completely. 

⇒ Once you are satisfied, in the “File” menu, us “Save as Template’. 
⇒ Now, for any new HUD, in the “File” menu, use “New Based on Template” and select your templates. 

All prior calculations as well as any information entered will be automatically available. 
⇒ For more details on “Templates”, see section in “Productivity Features”. 
 

Section 2: Productivity Features 
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1. I need to prepare a HUD form which only displays buyer side portion (or seller side portion), or a HUD 
which does not show totals. How do I do that? 

⇒ If you have “Advanced Printing” module licensed as part of your Easy HUD, click on “Modules” and 
select Advanced Printing. 

2. Can I enter information about commonly used parties (buyer/seller/lender etc.) and use it in HUD 
preparation instead of re-entering each time? 

⇒ Yes. Under “Tools” menu, select “Case Management”. Here, you can enter your contacts’ 
information. Once a contact has been entered, in the HUD software, you can use icon in the 
borrower/seller/lender sections to use any of the previously entered contacts. 

⇒ If you want multiple users to share contact database instead of each user creating their own, follow 
these steps: 

a. Under “Tools”, “Default Settings”, “Configuration”, ensure that Easy HUD Database Location 
directory is pointing to a shared location. 

b. For all users’ machine, this setting must be same.  
3. What are Templates and How do I use it? 
⇒ Templates is a feature which allows you to pre-set your HUD any way you like it. For example, if you 

do closings for a particular lender or a title company again and again, you can create a template for 
that lender and pre-fill as much information as you would want.  

⇒ To create a new template, create a new blank HUD, enter as much data as you would like (do not 
enter any transaction specific information as it will change). For example, you may fill-in lender’s 
section, many charge names in section 800, 1100, 1300 etc.  You can also custom enter “Recording 
charges” and “Transfer Tax” rates in the section 1200 calculator. 

⇒ Once you are satisfied, in the “File” menu, use “Save as Template’. 
⇒ Now, for any new HUD, in the “File” menu, use “New Based on Template” and select your templates. 

All prior calculations as well as any information entered will be automatically available. 
⇒ If you only have one template, you can set it as default under “Tools”, “Default Settings”, 

“Configuration”, 
4. How do I edit previously created Templates? 
⇒ Open a new HUD based on template you want to edit. 
⇒ Make necessary changes. 
⇒ In the “File” menu, use “Save as Template”, and overwrite on previous template.  
 

 
Section 3: HUD-1 Preparation Guidelines 

 
General Guidelines 
 
1. POC Items: The new rule expressly provides that for items paid outside of closing (P.O.C.), the 

settlement agent must display the party making the payment, such as P.O.C. (borrower), P.O.C. 
(seller), or P.O.C. (lender). If you are running out of allowed number of characters, you may want to 
use shorter format P.O.C.(B*) or P.O.C.(S*) or P.O.C.(L*) provided you turn-on the footnote printing 
by using “Add POC Footnote” button at the bottom of Page2 of HUD-1 and Page1 of HUD-1A. 

2. Processing & administrative service fees should not be itemized. Examples of such fee are document 
delivery, document preparation, copying, wiring, preparing endorsements, document handling and 
notarization.  If any part such fee is performed by a third party (example: loan documentation 
preparation by lender’s attorney), those are still not to be itemized. Such fee needs to be included as 
part of the main category charge: 

a. Line 801: All loan origination fee including loan documentation preparation/review. 
b. Line 1101: All title and closing related fee except for owner’s title insurance premium (line 

1103). 
c. Line 1102: All third-party charge for conducting the settlement. (Line 1102 Buyer side 

charges always included in Line 1101. 
d. While RESPA rules do not allow itemization, your client might want to see itemization. Easy 

HUD comes with a feature “Smart Itemization”. Look for an blue image next to many boxes. 
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You can enter your detailed itemization and even print an itemization report. You can meet 
both HUD’s and your client’s requirements with Smart Itemization. 

3. How should settlement services included on GFE but paid by a third-party (seller, realtor, lender) 
shown? 

⇒ All GFE included items must remain in borrower’s column irrespective of who paid for it. An offsetting 
credit to be shown on Lines 204-209 identifying the party paying the charge. For a seller-paid charge, 
the charge should also be listed in Lines 506-509. This is critical as otherwise GFE-HUD comparison 
sheet can not be prepared correctly.  

⇒ If the use of a HUD-1A (which does not have 204-209 lines) form is not appropriate, such as if there 
is a credit given by a loan originator or other party, use HUD-1 form. In that case, you will need to use 
Section 100 or 1300 to pay of third-party disbursements which are typically on 1500 section on HUD-
1A. If you use section 1300, keep “Included in Line 1301 box OFF” for these charges. 

⇒ To keep track of all such items where responsible party and paying party are different, Easy HUD has 
a “Set Off” tool. Look for it under “Tools” menu. 

4. FHA loan requires seller paid closing costs to be itemized. New RESPA rule requires seller paid 
closing cost to be still shown on borrower side and use offsetting credit on Line 204-209 and charge 
to seller on 506-509. How do I meet both the requirements? 

⇒ It is not clear what would be the correct approach would be. We also did not find any guidelines 
provided by HUD in their documentation. We can think of possibly 2 options: 

o You have to show borrower’s cost (irrespective of who paid) in the borrowers column as 
explained above. However, while doing offsetting on 204-209 and charge on 506-509, 
you may itemize it individually rather than doing a lump-sum adjustment. 

o Or, if you do lump-sum adjustment, you can show itemization out of the column below the 
lump-sum line (there are plenty of extra empty lines).  

5. When the borrower is using a second loan to help finance the purchase of a home, may both loans go 
on the HUD-1? 

⇒ No, each loan must have a separate GFE and a separate HUD-1. The principal amount of the second 
loan must be listed outside the borrower's column with a brief explanation on Line 204-209 of the 
HUD-1 for the primary loan. If the net proceeds of the second loan are less than the principal amount, 
the net proceeds may be listed on the same line in the borrower's column. 

6. If Bucket 2 total HUD charges are higher by more than 10% of the GFE charges, does the lender 
need to make a refund of the entire “higher” amount or only above 10%. 

⇒ We believe lenders only need to makeup for amount beyond 10% as upto 10% increase is allowed for 
the bucket 2. So for example, if Bucket 2 is higher by 15% which is a violation, lender is required to 
reimburse only 5%. 

7. What happens when Lender makes extra disbursements to correct tolerance violations?> 
⇒ If lender makes extra disbursements at the time of closing, on the HUD, in the section for which 

correction is being made, enter extra disbursement as POC item. Example, to cure for $200 of 
transfer tax charges, on line 1206 outside the column, enter “Transfer taxes $200 P.O.C.(lender) to 
meet tolerance”. 

⇒ If the cure is being made after the closing (lenders have 30 calendar days) to correct for tolerance 
violations, a modified HUD-1 will need to be prepared as shown above to show the cure. Lender can 
issue refund directly to borrower or via settlement agent. 

8. An inadvertent or technical error in completing the HUD-1/HUD-1A could be cured if a revised HUD-
1/HUD-1A is provided in accordance with the requirements of the new rule within 30 calendar days 
after settlement. 

 
Section 700 (Realtor’s Fee): 
 
1. This section is identical to old HUD forms with the exception that broker’s % fee is not shown on the 

printouts. 
2. In the Easy HUD software, you can still compute the total fee using % and split among 701/702 lines 

using split % box. 
3. If a Realtor is retaining some of the borrower's earnest money deposit as part of the agent's 

commission, is that amount listed in the 700-series on the HUD-1? 
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⇒ Yes, if a real estate agent is retaining some of the borrower's earnest money deposit, the amount of 
the earnest money deposit applied towards the commission and the party holding the earnest money 
must be identified on Line 704 of the HUD-1 as Paid Outside of Closing or P.O.C. Only the amount of 
the commission disbursed at settlement is entered in the columns on Line 703. 

4. Section 700 charges are not part of any GFE-HUD comparison sheet buckets. 
 
 
Section 800 (Items Payable In Connection With Loan): 
 
1. 801, 802 and 803 are bucket 1 items. All lines 804 onwards are bucket 2 items. 
2. Line 802 is net of (points paid – yield spread premium). It could be a positive (if points paid are more 

than YSP) or negative (if YSP is more than points paid). 
3. If a borrower pays some of the origination charge prior to closing, how should it be disclosed on the 

HUD-1? 
⇒ Lines 801, 802, and 803 of the HUD-1 may not contain any "Paid Outside of Closing" (P.O.C.) items. 

If the borrower pays some of the origination charge before settlement, an offsetting credit in that 
amount is shown on the first page of the HUD-1 in Lines 204-209.  

⇒ Tip-> In such situation, keep “NET” flag on. While preparing ledger, it will then balance out itself.  
4. In lines 804 onwards, do not list any charge which is not in GFE Block 3 (Required Services That We 

Select).  
5. If a loan originator permits a borrower to shop for services labeled in this section (e.g. 806 tax service, 

807 flood certification) should those be listed in 800 section? 
⇒ No. If borrower is permitted to shop, those charges will not be on GFE Block 3 but instead would be 

on Block 6. On HUD, these charges are to be listed in Section 1300. 
 
Section 900 (Items Required By Lender To Be Paid In Advance): 
 
1. Line 901 is a bucket 3 item, 902 is a bucket 2 item and 903 is a bucket 3 item. 
2. 904 & 905 may be part of tolerances (if those are listed on GFE). If these items are listed on GFE, if 

the provider is lender identified, these belong to bucket 2, otherwise bucket 3. You will need to make 
this selection on Page 3. 

 
Section 1000 (Reserves Deposited With Lender): 
 
1. Line 1001 is the net amount of lines 1002 - 1007. 
 
Section 1100 (Title & Closing Charges): 
 
1. What items are included in the amount disclosed on Line 1101 of the HUD-1? (from HUD FAQ) 
⇒ Line 1101 is the total of the charges for ―Title services and lender‘s title insurance, which includes: 

all charges for conducting a settlement (Line 1102); any premiums paid for lender‘s title insurance 
and its related endorsements (Line 1104); all charges for title searches and examinations; and 
charges for all other services itemized in the 1100 series if those services are included in the 
definition of ―title service. The total on Line 1101 should not include the amount of any premium for 
owner‘s title insurance and its related endorsements, which must be listed in the columns on Line 
1103.  

⇒ To facilitate automatic totaling of line 1101, Easy HUD has a separate box to collect “Misc Title 
Charges” which is basically title charges which are not allowed to be itemized but are part of 1101. 
Easy HUD will automatically total 1101, which is going to be the sum of Misc Title Charges, 1102, 
1104, 1107, 1108 and any other line with “included in Line 1101” flag ON. 

2. How should buyer/seller’s attorneys fees be recorded on Easy HUD 3.0 (Assumption is buyer’s 
attorney is the settlement agent): 

a. ALL fees pertaining to functions necessary to conduct the closing, provide title services or 
issue the lender's title insurance policy must be recorded on line 1102 for both buyer’s and 
seller’s attorneys. Administrative fees such as copy/courier/fax/phones must be included in 
these charges and not to be separately listed anywhere. 
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i. If there are multiple parties involved in above functions, total must be shown in line 
1102. For example, you are an attorney and outsource closing documentation 
preparation, all fee pertaining to these activities would be added to this line.  

b. Line 1101 must include buyer’s closing/settlement fees itemized on 1102-Buyer. 
c. ALL legal fees not pertaining to what is required to be in 1102 (see above) can be recorded 

on a blank line of 1100 series (e.g. 1109) and can be titled as “Legal Services” or “Personal 
Legal Services”. These amounts will not be included in line 1101, will be recorded directly in 
borrower/seller’s column and will not become part of any bucket. Examples of such services 
are contact drafting, negotiations, seller concessions, and any additional legal services 
required by borrower or seller. 

d. See section below related to “GFE-HUD compare sheet” preparation to understand how 
compare sheet will be prepared depending on closing agent/title agent part of the compare 
sheet, only one is part of or none is part of. 

9. How to record attorney’s fee when lender’s attorney is the settlement agent? Buyer & Seller might 
have their own attorneys as well as part of the closing process.  

a. Lender’s attorney fee pertaining to conducting the settlement, title review and post-closing 
activities are shown at 1102 and it automatically gets added to 1101-B.  

b. Lender’s attorney fee pertaining to loan documents review must be included in 801 and can 
not be separately itemized. 

c. If buyer and seller have their own attorneys, you might use a blank line of 1100 section (e.g. 
1109) and charge fee in buyer/seller columns. 

 
Section 1200 (Govt Recording and Transfer Charges): 
 
1. 1201-B can include items more than 1202 such as Power of attorney recording etc. Those additional 

items will be listed on 1206 with amount out of the column and 1201 total to be updated to include this 
amount. 

2. Any recording fees for seller item such as release should be recorded on seller side and will not 
become part of 1201. 

3. Section 1201 must have only the actual recording charges paid, not charges to prepare documents. 
Preparation charges are considered administrative fees and must be included in 1102. 

4. Line 1203, "Transfer taxes" is the total of state and local government fees imposed for mortgages and 
home sales. Amount paid by seller should be included in line 1204/1205 and amount paid by buyer 
should be shown on line 1203-B. 

5. In some states, lender pays part of the mortgage tax (e.g. NY). How do we show it in section 1203? 
⇒ If the GFE Transfer Taxes (section 8) shows as this amount included, then you can show it in line 

1205 Mortgage, and it will automatically added into Line 1203 as borrower payment. This is required 
as in GFE-HUD compare sheet, it will be shown correctly. (remember, Transfer Taxes are 0 tolerance 
item, meaning can not increase even by a penny).  Since lender actually paid for it, you will need to 
use line 206 to provide credit to borrower for this charge. See section Set_Offs for details about how 
to record such transactions. 

⇒ If the GFE Transfer Taxes (section 8) does not include this amount, you can simply show this as 
Lender Paid POC item in line 1206 or 1207. Do not use $box there and only use the 1st box for text as 
well as amount. This will simply be to show notation about this payment.  

 
Section 1300 (Additional Settlement Charges): 
 
1. What charges are shown in the 1300 series of the HUD-1 Settlement Statement? (Copied from HUD 

FAQ) 
⇒ The 1300 series of the HUD-1 Settlement Statement is used to record the charges for settlement 

services that are disclosed in Block 6 of the GFE as well as charges that are not disclosed on the 
GFE. Examples of some of these services may include charges for home inspections, radon 
inspections, and homeowner‘s warranty. 

⇒ ALL GFE Block 6 items must be entered on HUD-1 with “included in 1301” flag ON. These would then 
be automatically added to 1301 and will be itemized outside the column.  Tolerances for these 
charges would need to be selected on GFE-HUD comparison sheet.  
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⇒ Any additional charge which is not listed in GFE must be without “included in 1301” flag. These items 
will be printed in the column and will not be part of the GFE-HUD comparison sheet. 

 
Section 4: How to Prepare GFE-HUD Compare Sheet with Easy HUD 3.0 

 
Guidelines from RESPA Rules 
 
1. GFE items which are partially/fully POC: In the compare section, enter POC amount. Total of 

HUD+POC will be used to calculate tolerances. 
2. GFE-HUD compare sheet is not required to be given to seller, as it pertains only to charges to the 

borrower and loan information.  
 
Automatically Prepare GFE-HUD Compare Sheet 
 
1. Before starting the HUD file, ensure you have a copy of the latest GFE issued along with any 

separate sheet provided by the lender which identifies settlement service providers. Instruct borrower 
to provide you any GFE issued by the lender, as lenders are allowed to reissue GFE under “changed 
circumstances”. 

2. Easy HUD 3.0 automatically prepares compare sheet (Page-3 for purchase and Page-2 for 
refinance). You are simply required to do the following: 

a. Enter GFE amounts in the corresponding lines. 
b. Enter POC amounts in the corresponding lines. 
c. For most of the GFE-HUD compare lines, tolerance requirements are fixed. However, for 900 

series lines starting from 904, 1101, 1103 and 1300 series lines “included in 1301”, you will 
need to select tolerances. If the settlement service provider is lender identified, you will select 
“10%”, otherwise select “can change”. 

3. How to prepare GFE-HUD Compare Sheet if “Lender Identified Provider List” identifies separate 
service providers for “Lender’s title insurance and related services” and “settlement/closing agents”? 
In many parts of the country, Title agency and Settlement Company are two distinct entities. In such 
cases, lender may provide separate list of providers for services included in GFE Block 4 (Title 
services and Lender’s Title Insurance). In such cases, estimate fee of title agent and settlement agent 
will be listed along with their names on the provider list. Total of both these estimate must total to 
GFE Block 4. 

a. If consumer chooses neither service provider from the list, compare sheet will only have one 
item in Bucket 3 which will list GFE Block 4 charge and HUD-1 Line 1101 charge. This choice 
will be made by you while selecting tolerance requirement on page3 of HUD in Easy HUD 
software.  

b. If both title agent and settlement agent are on the list, compare sheet will only have one item 
in Bucket 2 which will list GFE Block 4 charge and HUD-1 Line 1101 charge. This choice will 
be made by you while selecting tolerance requirement on page3 of HUD in Easy HUD 
software.  

c. If the consumer chooses one provider from the list, preparation of compare sheet gets slightly 
more complex. You should follow these steps: 

i. Prepare your GFE-HUD compare sheet as close to final as possible. 
ii. Keep the original line created “Title Services and lender’s title insurance” in top 

section where it was originally listed. If you had already selected its tolerance, locate 
the record and select its tolerance back to None. We will not be using this line as this 
line needs to be split into 2 buckets. 

iii. Add a line in Bucket 2 (click on Add New) for the provider who is on the list. Enter 
details along with GFE estimates (estimate from the list, and not GFE Block 3) and 
actual HUD charges (If its Title Agent, 1101-1102, if its Settlement Agent 1102). 

iv. Add a line in Bucket 3 (click on Add New) for the provider who is not on the list. Enter 
details along with GFE estimates (estimate from the list, and not GFE Block 3) and 
actual HUD charges (If its Title Agent, 1101-1102, if its Settlement Agent 1102). 

v. What we have basically done is instead of one entry, we now have 2 entries but in 
different buckets, as one provider is from the list and other note. Ensure that of these 
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2 lines in GFE matches with GFE Block 4 and total of HUD amount matches with 
1101. Our originally created line will remain unused in the top section.  

 
Manually Prepare GFE-HUD Compare Sheet 
 
Easy HUD 3.0 automates preparation of the compare sheet as much as possible. Since HUD line 
charges can keep changing until the date of the closing, it is recommended that you use the automatic 
feature. However, in some unique cases, if you must prepare the compare sheet manually, you can check 
the “Manual compare sheet” checkbox at the top of the section. Once this is selected, you will have full 
flexibility to enter/edit lines of the 3 compare boxes and what you type will be what gets printed.  
Remember, if at any time, you uncheck the “Manual compare sheet” box, you will loose all manual 
changes made and compare sheet will be re-created from scratch using the automatic functionality of the 
Easy HUD 3.0. 
 
Special Printing Controls of GFE-HUD Compare Sheet 
 
Due to significant importance of this page for lenders, different lenders are asking for different 
requirements, which in some instance may even be conflicting with RESPA rules. This section will help 
you understand how Easy HUD’s GFE-HUD compare sheet printing works and how you can 
accommodate special requirements of a particular lender. 
 
1. Easy HUD automatically “extracts” relevant settlement charge lines into compare screen and places 

those in appropriate buckets. You just need to make “tolerance selections” in the top grid, and enter 
POC, GFE amounts for each line. HUD Amount is automatically updated from the page2 charges. 

2. On page2, most lines are entered in 2 boxes (description and Pay To). If you are using a line purely 
for notes purpose, enter notes in the “first” box. If “second box” AND borrower amount is blank, those 
lines will not be extracted into the compare sheet. 

3. Lines Printing Control on the printouts: 
a. Eight required lines (801, 802, 803, 1203, 1201, 1001, 901, 903) will always print. 
b. All other lines “automatically” extracted in the grid will only print if one of the 4 amount boxes 

(POC Amount, HUD Amount, HUD Total and GFE Amount) is non-zero. 
c. All user entered lines using “Add New” will always print irrespective of any amount is entered 

or not. 
d. If “Manual Compare Sheet” checkbox is ON at the top of the screen, all lines shown will print. 

4. Amount Printing Control on the printouts: 
a. For eight required lines, if no amount is entered, it will print as 0. 
b. For all other lines including user entered lines as well as when manual mode is ON, if ALL 4 

amount boxes are zero than those would be left blank. Otherwise, entered value or 0 will be 
printed. 

5. In the 10% tolerance section, when GFE amount exceeds HUD total, different lenders have asked for 
different way of showing the increase amount on the print outs. 

a. Some lenders want it to be shown only if there is an increase (we believe this is correct 
position). 

b. Some lenders are asking it to be shown as 0. 
c. Some lenders are asking even the negative amount to be shown. 

⇒ To accommodate all such requests, there is an option in this section “Print Option if GFE-HUD 
increase is negative”. Choose from one of the 3 choices available. 

6. You can always enter extra lines in the grid by using “Add New” button available with all the grids on 
the compare sheet. 

7. You can always convert to manual mode which provides you full flexibility. However, HUD amounts 
will not be automatically updated if there was any change made on page2.    

8. My lender still wants extra language/notations to be shown which I am not able to accommodate in 
Easy HUD? 

⇒ All prepared print-outs are fully editable and you can type anything wherever you want. Click here to 
learn more about how to edit printouts.  
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Section 5: How to Prepare Disbursements 
 

Easy HUD’s optional Ledger module prepares disbursements and has functions to print checks and 
export closing transactions for trust accounting. Follow these simple steps: 
 
1. While preparing HUD, mark lender disbursed items with “NET” flag. NET flag indicates that lender is 

deducting these charges from the funding. 
2. Prior to preparing disbursements, review “Lender Worksheet” under “Tools” menu.  Lender worksheet 

lists gross amount of the loan, all netted items and net amount of the loan. Net amount must match 
with amount being funded or you must have an explanation for the discrepancy (e.g. lender might 
have added disbursements to be made to broker as extra payment to funding). 

3. Click on Ledger. If you have previously clicked on ledger and then made substantial changes to HUD, 
you can click on “Re-Import Ledger”. This would discard your previous ledger and re-import HUD 
data. 

4. Ledger will show closing transactions taking into consideration NET flags. Net loan funding will show 
as deposit and charges which are marked as NET will not be listed. Following lines are provided with 
special treatments: 

a. Line 701, 702 and 704 charges: If as part of Line 201 (Earnest Money) any money was 
indicated to be withheld by 701/702/704 brokers, their disbursements will be netted by this 
withheld amount. 

b. 1101 disbursements will be NET of all “Included in Line 1101” disbursements except for 
1104.  All “Included in Line 1101” will be prepared as separated disbursements except for 
1104. 

c. 1103-B and 1103-S disbursements will be separated rather than combined as these are 
normally paid to two different parties.. 

5. Once Ledger is prepared, you can combine multiple checks into one, split a check to multiple 
disbursements, remove transactions, add transactions, mark transactions as wire. 

6. Finally you can print checks and a Ledger Disbursement sheet.  
 

Section 6: How to Prepare and File 1099-S 
 

Easy HUD’s optional 1099-S module and our electronic filing service allows you to meet all of your 1099-
S requirements. Before you can start electronic filings, ensure to register in the filing service which will 
issue you your account name and password. 
 
Steps for Electronic Filing Enrolled Customers 
 
1. Once HUD preparation is complete, “print 1099-S Substitute Form” under the 1099-S tab. 
2. At the time of closing, get this form signed from the seller. This is important as seller needs to certify 

about accuracy of seller’s tax ID number. 
a. In some states such as NJ, Seller’s attorney prepares this 1099-S form and delivers to 

buyer’s attorney at closing. Buyer’s attorney then files it. In such case, you may just create a 
new file and complete 1099-S portion without worrying about the full HUD form. 

3. After the closing, click on “Submit 1099-S” under the 1099-S tab. You will be asked to enter your user 
ID and password. 

4. Upon successful completion, you will be issued a confirmation number in the Account or Escrow 
Number section. There is no need for you to provide a copy to the seller.  

5. 1099-S filing service will send an official copy to the seller few days prior to IRS deadline (For 2009 
filings, it was Feb 15, 2010) and in March will file your 1099-S to IRS.  You should not provide any 
1099-S document to seller otherwise to minimize any confusion. 

6. Under 1099-S tab, you can print a log of all your previously submitted 1099-S forms by clicking on 
“1099-S submission report”. 
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